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Noteworthy ltem

Action, click or enter

Sequence number
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1 Setting up the Workspace.

=

B launcher - - Bl
EasyCal

EasyCal Veer: |ssiadiit| [ “yigar #dmin
Launcher @
Results Results
Double B
Click Evaluation Evaluation
mApplication E‘Application
[~
e 1)
?& Tools K Tools

Applicatons
Meduie Editar

POTZre550

S2Configuatian

S25etup

DumpssD
Dump Method / Calibration

S2Setup

S+ Select Mode

@ EasyCal
) Full SpectraE DX

==

[ Cocal ]

| B Soeea pias ana soera £0K Sarup = H
Pioject Base Foides %USERFADFILE My Docunents\Biuken\51Cal E
Cafbibration database: ZUSERPROFILE %My Documents\Brokes\S1CahSd SS0AD stabase
Resills datahase: %USERPROFILES\My Documents\Bruken\S 108051 SS0AD sabase
Cordiguration ke CASPECOus C
Lines Bbeaty: \My Documents\BjukaitS 1Ca\Sd SSO\Libeasies\ | |
Path for standards: SUSERPROFILE %\My Documents\Bruken\S 1CaN51d S5O\, ibeasies)
Messurement methods path: | %1ISERPAOFIL Diocumentz\Bruken 51 CahSid SS0MMathads
Cabbastion methods path: XISERPROFILE X \My Documents\Bruke\5 1 CahSid S50 Libsasier'
Uset calculations pathc *USERPRD My Documents\Bruked\5 1 CahSid S50 Mathads
S24pp Path CASPEL e\ Calibe stiones',

Tempotaty 550 Path %USERPROFILE %\My Document:\Bruked\51Cah51d S50\ Libeasiesh
Specilicabons: database: SUSERPROFILE XMy Documents\Biule\S 1085 S50AD ababas
Base path for ausiliary fles: | apecs
Temporaty recults fle: C C dst i
Sp. Machine tocaho W]
&) EDe
ok | | Restwe, | [ Save. | Cancel

about “Project Base Folder”

See Appendix A for more information
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2. A New Calibration.

B Launcher -~ G_

EasyCal

Results

Evaluation

ﬂApplica\tion

Tools

Rl Masching: Vg Inpr - Dadoss Helg

= ApplicationWizard
File View Options Help

Dlsisd = D BB XDh 4 E3M 9w
1

New Application

New application name: I|

(O Time based erpiical @) Compton based empiical (O Sur ROl based empiical () User RO based empirical

Note

The internal standard selected when creating a new calibration will be used
as the default for each element as they are added to the calibration. The
active internal standard can be changed on an element by element basis at a
later point in the process. The default selected at this point cannot be
changed.

an. Ioe Wew Awens Celaon  Wedoe Gprens e !__i#:'x'l

DA *D]< 25 XD A EEM o]

[ 7ot Floain guth Nest” tuon
st S Materials
8- Measurement EasyCal ApplicationWizard Program
@0 Calibrstion :.wluumb:n\l\l\:ad makes & possible 1o define an XRF Application though a succession of steps, while prowding manual adustments and Sexibility st all steps to mesl complex specific
mal
E :’::I:;u To create a XRF application, pst follow the steps presented in the left explorer pane one h\r one, and save the document. The complele procedure creates an Application file (rame evm)
which containg referances to the method files of the application, together with vanous aptions which can be selectod at the last step of the process (the Apglication step) In adddtion an

installation package is created, with the <name> calibration, <name> aen and <name:> wrd files, which can be installed using 51 Sync
Opening a Spectra®™ Application file:

Usa the Fila | Opan command to open an Application (EVM file), of a Draft (DEVM file)  The Appiic: files ware farmarly refarred to as Evaluation Models in Spectra®™*
version 2 2 and below, but are now referred to as Application files. Draft oS Are i icati these will be converted to finshad Appheations ([EVM) at the last step
{the Application step)

Craating a new application from scratch:

Use tha File | Mew command. select the name for the new application and follow tha steps. A naw Application starts out a5 & Draft Applications (DEVM file)  This Draft Appécation
willl be comvened ta working Application (EVM file) in the last step (the Application step)

Making another application (e g with dfleren comections) kom the same data
1 Create an emply document, ghing it a nadme
2 Rivaiw the sleps dawn to the Calibration step making the same selections as befare
3 Dafine the new calibeation at the Calibration step.
4 Then procesd as usual

Detining a new compound (which will be avadable in the Materials | Compounds step)
1.Close all dogumants,
2 Soloct the menu File | Open Compound Library

(3 Tueora dove [

Imh‘mn
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a"wal Mamrial grougr: 1
- O= @
T [ :
- e = D O ic o L/
[ %::;:‘mn
'Wﬂhﬂn
E 9]
-a'hlmi.dlm
2.1 Select the elements.
DEBO> >< B3 XOh L EEMD 9o T
B s e
& Corvoos Hame | Fomds 2 Order  Special ﬁ
25 Standerds
1574 Messurernent
1§14 Calibration
ﬁmmls
BB 2ppication
i
1 e Y D e
R AR B« cf Es FmMd No
[ |
f%:-T_ﬂe-_J
,am_tm
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DEEa *DiK a3 Xan4umm ow
s A\ [ s
:’”‘:m .c:::m\ﬂrm Z  Dedw Specal IE
- | (EIE [ ] [N [0 |F INe ey
it Pl W[ 19 [arsi[P [s [ci]ar i
oo O < - | v N A oo ) 2 o= e[ o [ =R
Ro[sr[v [z |No [l e [Ru[Rh[Pd|Ag|cd] in [sn[sb[Te 1 [xe|
Cs[Bafta[Hf[7a |w [Refos] ir [Pt [AulHo| Ti [PoBi [Po] At Rn]
Fr Ac
1 T A E
N Y RS e cf Es Fm Md No
[Casin |
Tye:
[t om0 |
ﬂm-ddn-[
JF’WW — b
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2.2 Adding Compounds.

| e Emt vew Memes Cattismen Windoe Opners e
| : 5 ' [
Dssd DK 85 AR 4 wEm 93|
2 Tutorial
-5 Materials
o Elements
E Compounds Broc Az |
Standards HZ B Copper w2 & |
B e oz wz s ban Fe ® 4 |
1B Cacamlhu., CaF2 20 Mangsn Mn = 3
- Calibration Cachmca_ Ca003 20 Mobbds.. Mo 42 7
B g Cabondo. C0Z 6 Nickel i ® 5
— Cebdoss  CBHI. 8 Vanadm ¥ 2 1
T apphcation Conderte  2Mg. 14
Hx Hx; 1
HOl HO W7
fon (). FedDd 26
bonllcwd  FeO 26
Ironsuifide FeS 16
Lol mz &
Lifhiumksa . LET )
Libnmal.. LBD2 5§
Uthiumbesr | 128407 3
Manganes,, Mn203 235
Mangsnes.. M2 25
Mad04  Mn304 25
byl CIH. 6
oF [T
Polycasbe..  CI6H. B
Poypropyl.. CHZ &
Tungeten . WL T4
Wales W 1
Wan oz B |
'L]‘ |
'i,_i] Titorsl dewm
For Hain cowss FL St
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2.3 Enter Standard Sample Names and Concentrations.

T tew fwe  Mems: Cetsse  Westmn o Opmom e

DEEH * >< &b ¥XDh < ¥EM 9w

g 1ol Moeinl e | S -l i -]
¥ ” [ IR 7 ko ew sterir g
| “‘“""“" stesvabers g 10 [Beron gt |
Standards § i
- T Mesurement i ] Enter the name of
Calibration
* - joa Standard Samples
= spplication
anncll peu [T %
_Cusonbnke || ] (] (Fase i i
[Tome ‘B fo Balarce, “T or Taces o s contestun me. [
") Tt o |
For Fl ———— s
P Gav Ves Meeoo Celmwoe  Secoa  OpEnce e :5 x
DS > > (BB XD A EBM 9 :
[
IBTM ) ! =1 < Maedsl | -]
T e e s _ o s 5509 2
[ compounds e yobdtn, 0310 [ Gomem i |
|| Standiseds - —
i Memurement T T T
- Calirstion ¥ I X rogh
= SEEEE -
T 35 T T T
T T T T T
T T T iT; T
I Units: PPM, % or Custom (omt Fom i i I
" 12 Tidara o [
lhua—ﬂ. — s
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Alftes validation, goto |Botham Right |

S Fi N
245 049 0138 1197 T
232 0194 0652 0228 T
301 0341 0463 1677 T 0223 0221 0.088
254 0107 0774 0532 T 0393 0427 0307
167 0411 0206 0903 T 0.102 0022 0.025
T
T
T
T

0019 0101 0495
0808 0302 0.14

535 001 2001 0447 162 0289 098
517 019 303 019 0527 0397  0.83
566 0.067 0111 0557 413 06%4__ 0.098
571 0008 1318 0559 302 02050599

Defaullt is Trace

Eiegeeee:

O
T

-ba\ (= T = Tutorial Cone
‘—) Home Insert Page Layout Formuias Data Review View
o] ¥ Cut o || =
J Calibri {11 = [l = -Il‘v)"l &= Wrap Text
- <3 Copy :
Paste o ormot painter ||| BY L T~ [E ][> A || ME B 300 60| B Merge & Center -
Clipboard - Fant I Alignment ]
| Al -
Ctrl-C M%) o Paste with Titles
TSR 100 1197 0138 0495 0019 0101  0.496
3 553402-2 100 0.228 0.652 0.14 0.808 0.302 0.194
4 155403-2 100 1.677 0463 0088 0223 0221 0341
) 555404-2 100 0.532 0.774 0.307 0.393 0.427 0.107
§ 155405-2 100 08903 0206 0025 0102 0022 0411
7 555406-2 100 0.447 2.001 0.98 1.62 0.289 0.01
8 155407-2 100  0.195 3.03 0.83 0527 0397 0.19!
9 ESS-‘IOS-? 100 0.557 0.111 0.098 4.13 0.694 0.067
10 'S5409-2 100 0559  1.318  0.599 3.02 0205 _ 0.008)
11
Material group: [N Matesial group. [N
Bl o [is0 x Umts: (10 |[1050 | %
Alter valdation, goto I Bottom  Right After vabdation, go o | Botlom  Right I
Sum (% Wl Fe(%) (Ml Cu i) : ; C
55401 1.25 T 0496 0138) T | 0013 0101 0.495 S$5401 X 0019 0101 0.495
55402 210 T 0.194 0652 0808 0302 0.14 55402 232 0194 0652 S aas—A.a8n ol
55403 1.3 T 0.341 0463 0223 0221 0.088 S5403 30 0.341 0.463 Copy
55404 201 T 0107 0774 0393 0427 0307 S5404 254 0107 0774 Copy All
55405 N T 0411 0206 0102 0022 0025 | ([SS405| 167 0411 0206
55406 490 T 001 2001 162 0289 0.98 55406 535 0.01 2001 Paste
55407 497 T 019 3.03] 0527 0.397 083 $S407 517 0.19 3.03 s
55408 510 T 0.067 0111 413 0694 0098 55408 566 0067 0111
55409 515 T 0008 1.318 302 0205 0599 55409 571 0.008 1318
|-22403 | |- 24U9 |
Line Balance
Unit »
Format »
Column Decimals »
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Matenal group: [N

Umits: 1.0 1050 | %
Alter valdation, 9oto: [ Batom _Rioh | A vakdaton, g0 0: [ Botom_Figh |
55401 9 0019 0101 0495 55401 | 0019 0101 0495
| 55402 | R 55402 | 0.808 0302 0.14
55403 Lopy 'S5403 | 0223 0221 0088
55404 | Copy All 55404 | 0393 0427 0307
$5405 : 55405 0102 0022 0025
55406 | i S5406 162 0289 098
S§5407 | Tiace 55407 0527 0397 083
55408 ; S5408| 413 0694 0098
55409 | 55409 302 0205 0599
Column Balance —— : B B
Line Balance
Unit »
Format »
Column Decimals »
izard - - ===

The definition of the material has been changed at this step: do you
want to save the changes?
Nete: the standard matesials will be saved in their modified state as well

L ve JJL % |

030.0101.03.0
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3 Measuring the Assays.

3.1 Creating the Run Order.

A P B Vew Memsg

Window  Cptoms e

DS HOK 83 Xoh aEEm o

L& Tutonal Pl puch Moot buston
- i Materiai
lff tlements Measurement
@ Compounts The sleps below e related 1o the method and and to the of the standad sampies

Tutenal

- Materials

C 2 Tutorial 2m

= \S
I Run Order Wizard
I PDZto SSD
@ catibration
BB Modules
B Application

Curent material : Tutorial

Fiun Dsder Wizard

Run Order Wizard

Purpose

To create a “run order” file associated wath this calibration. A run order is a file that automates the
collection of spectra for samples.

First use Bruker Instrument Tools to copy the InstrumentDef.IDF file from the instrument to the
base folder of your EasyCal program. For example to "C:\Users\JohniiMy
Documents\BrukenS1Cal\". If you have a Tracer 5' you will also need to copy
\Bruker\System\ManualFilters.csv to your base folder

Then click on Run Order Wizard and ApplicationWizard will open Run Order Wizard for you
Once open, choose the appropriate settings and click "OK".

The run order file has a * csv” extension. It will b saved in the location indicated at the top of the
Run Order Wizard program in a folder with the same name as the Calibration. For example

e \JohniMy D S1CalRunOrders\Allays\Alloys csv'. Nota that thers are
two additional files created in the same directory- S1-LineLibrary xrd and S1-LineLibrary-A1 fil
Ignore these files

Copy your run order file into a folder called "RunOrders” on a USB drive. You can do this directly
by inserting the USB on the PC_ Or by using BIT explorer with the USB inserted on the
instrument and the instrument connected to the PC.

Insert the USB drive into the instrument

Use the Run Order utility on the instrument ta collect data from your samples. (Ready-to-Test >
Utilities -> System Setup -> Run Order}

The reference sample measursment files will be archived in 3 7z type file in the SeqRun folder on
the USB stick. The name of the file is identical to the Run Order.

When finished, remove the USH drive and put it back into the PC or transfer the files from
SeqRun folder to the PC using BIT

Run PDZ to SSD to convevrt and copy the files to the required destination by the Wizard

S s e A 7

strie

13 Totosldevn |

For Hep press FL

030.0101.03.0
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Run Order Wizard “

Could not open C:\Users\IEUser\My Documents\Bruker\S1Cal\llluminations.dat.
This is normal on the first run.

- Run Order Wizard
Build Number Serial Number Run Order File output location
[SMX-I 08 |SM>(-1 08 C:\Users\EUser\My Documents'\Bruker\S 1Cal\RunOrders\T utorial
I
alibration:
' 2l [l
P 1 [T utorial
{ [ss4m
55402
{ |ss403 :
. |ss404 Name
$5405
55406 | Tutorial ~] |
55407 i .
i |ss408 | !
$5403 2 o Air " Flush  Wacudim |
! Voltage [ kV ) Current [ pa | Seconds Collimator [ mm )
- |30 |20 |1u |8
Filter \Wheel Manual Filter
[No Fiter v |NoFilter -
Save lllum

| Delete llum
{
Remove Standards | Reset Standards | || Create Run Order |I 3 Cancel

3.2 Transferring the Run Order to the Instrument.

IR LJJ » Vosman, Frits » My Documents » Bruker  SiCal b RunOrders ™ Tutoral

: Fia Edr View Tools Haelp

Organize = [:XJ Open = Share with + Print New folder

L. .android - Name Date modified Type Size

L d

I :J: L ﬁ.—].iﬂtll‘brﬂl}hll’d 5/26/2016 1:02 PM XRD File 52 KB
§

~ g i 1_linel ibrary-A 5/26/2016 203PM  FLL File 109 KB
v '*t":-"“‘ 5/26/2016102PM___ Microsoft Excel C... 1K8|
. vagrant. e 5

: :r:u . X-108.7z 5/25/2016 11:14 AM _ 7Z File 24 K8
. -Virtuaibox

L. AppData

030.0101.03.0 Page 13 of 38
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Drag csv file to USB stick into RunOrders folder
(B
» Computer » MUSHKIN (G:) » RunOrders = el

Edt  View Tooch Help —

Organize » (J Open Print Bum Mew folder - T ]

PHOTOS «MAS A e e T e

Spectra Files
Move USB stick to the intstrument
3.3 Running the Run Order.

- =]

- K=

Results Backup Data

SETTINGS
Alloys500 e

METHOD DISPLAY Pziote Control File Explorer

Auta Grade 1D

Utilities Edit Info

Library
APPLICATION ? < Se
APPLICATION Maintenance Y Date\Time

T Trigge Pl (P Daclay - Hee

Ha Trgge Pul[Fa ) Dpley Hely Fle Trigger Rfease [F5) Dhley  Hee
o & a-»
RunOrder File RunOrder File RunOrder File
||Tuturia|.cs\r H ‘ |Tuturia|.csv l |Tut0nal.csv

Seq# [P Length :ﬁo Seq # Length
Sample # _ Elapsed [8 Elapse

Sample # RunOrder

GGy [ utorial

X-Ray Beam Configuration

complete!

Wacuum

Vacuum

030.0101.03.0

Page 14 of 38



EasyCal — A Comic Strip

3.4 Transferring the Data to the PC.

Move USB stick to computer

.
| » Computer » MUSHKIN {G:) » SeqRuns - |4, || search SeqRuns ol
- = = - -
Pl Edr View Took Hep
Organize Share with » Burn New folder =+ 0 8@
3¢ Eavorites *  Mame . Date modified Type Size !
| ) Tutorial 201502051714325MX-1087: | 2/52015526PM  TZFile 2K8
B Desktop | Tutorial 2019R051714325MX-108-logs.72 SEPM TZFile 54 KB
4 Libraries
|| Documents
o Music ]
I I/ Pictures

Drag the 7z file from the USB to the computer.

RunOrders » Tutonal

. » Vosman, Frits » My Documents » Bruker » S1Cal

File Edt View Toos Help

Organize = [Zl Open = Share with + Print ew folder

.android ~ Name : Date modified
«dnx
.nbi

b

= 5/26/2016 1:02 PM
ks

. .oracle_jre_usat

b

ke

'™

5/26/2016 2:03 PM
5/26/2016 1:02 PM
5/25/201611:14 AM

|| Sl-LineLibrary.xrd
|| S1-LineLibrary-Al.fl

I [=) Tutorial_201605251105315MX-108.72 I

~vagrant.d
NirtualBox
AppData

Type

XRD File
FLL File

Microsoft Excel C...

TZ File

Size

52 KB
109 KB
1 KB
24 KB

030.0101.03.0
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PDZ to SSD

Source PDZ Files Directory

Destination S50 Files Directory

Force Build Number To: |

0 pdz files, 0 ssd files, 0 DataCollection files selected

CADocuments and Settings\Frits Documents\BrukenS1Caly HLibraries\Malkrials\ TutariaSolid:

Convert PDZ to SSD

Source PDZ Files Directory
i

Destination SSD Files Directory
|G\Dncuments and Settings\Frits\My Documents\Bruker\S1Cal\Std S5

Force Build Number To: |

0 pdz files, 0 ssd files, 0 DataCollection files selected

Browse For Folder

Select the folder containing the PDZ files

= ) My Documents
= () Bruker

= ) sical

Ei -

030.0101.03.0
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-

PDZ to 55D

Source PDZ Files Directory
C\Users\frits vosman\My Documents\BrukenS1CalRunOrders\ Tutorial

Destination SSD Files Directory
CiUsers\fits vosman\Documents\BrukenS1Cal\Std SSD\Libraries\Materials\Tutorial\Solids

Browse

Force Build Number To:

Convert PDZ to SSD ‘

0 pdzfiles. 0 ssd files, 1 DataCollection files selected

CalToolktt PDZ Tools

™S There are Data Collection 7z files in C\Users\frits vosman' My

‘.9.' Decuments\Bruken, SLCaNhRunOrders\Tutonal Do you want to process
== the contents of these files instead of the individual files in

Ch\Users\frits vosman\ My Documents!Bruker,S1CahRunOrders\Tutorial?

| .

030.0101.03.0
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.« My Documents (3 Bruker » 51Cal » Std 5SD ¥ Libraries » Materials » Tutorial »°
Fie  Edt View Tock Help I
| Organize « Include in library + Share with + MNew folder i @n
' 4P Eavorites =) Name # Date modified Type Size i
Bl Desktop 2| InstrurnentDef.idf 7/6/2016 4:57 PM IDF File 30 KB
El Downloads 55401 Solids.pdz 2/5/2015 516 PM PDZ File 9KB
il Recent Places 7/7/2016 1:08 P 55D File GKBE |
| A Vosman, Frits 5402 Solids.pdz 2/5/2015 5:18 PM PDZ File 9KB |
_ 2016103PM 5SSO File 9KE
< Bl Desktop 2| 55403 Solids.pdz 2015 5:19 PM PDZ File JKB
4 Libraries 7/7/2016 1:09 PM 55D File SKB
A Vosman, Frits 2/5/2015 5:20 PM PDZ File GKB
4+ 18 Computer J/7/2016 103N SSD File 9KB
'&_ 05 (C) 55405 Solids.pdz 2015 5:21 PM PDZ File SKB
ca DATA (D) 5 /2016 1:08 PM S50 File JKEB
= My Book (E) 55406 Solids.pdz 2/5/20155:22 PM PDZ File SKB
o Scans (k) 77772016 1:.09 PM SSD File JKB
5# Public ()} r=| 55407 Solids.pdz /2015 5:23 P PDZ File GKB
59 Apps () 2016 1:09 PM SSD File 9KE
¥ Data (L) /2015 5:25 PM PDZ File 3KE |
¥ Engineering (Q:) T/7/2016 108 PM SSD File 9 KB
# CAD Files (R:) 5409 Solids.pdz 2/5/2015 5:26 PM PDZ File KB
o Users (U2 7/7/2016 1:09 P 55D File JKB
5® Production (Vi)
# Sales and Marketing (\
€ Network =
P L‘ﬁ Control Panel
& Recycle Bin I
5] Document Locator bt |
] 19 items |
|
030.0101.03.0 Page 18 of 38
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<)
BRUKER
(<)

4. Setting Envelop background subtraction

The Envelope background

» - : — . option found on the
2 File Edit View Method Calibration Window Options Help

: e Calibration Menu can be
g P - +  Matenal Specific Lines Only g N9 )
DS o ' Enable Line Position Checking ﬁ HEO I used to configure how

¥ ApplicationWizard - [Limes.evm]

. lees Disable Automatic Regression element peak intensities
Enable Fitti del
- 3 Materials st M are calculated. Use of Net
&1 Measurement S Seraie Faameies intensity, the background
I Run Order Wiza Library Parameters under the peak is
PDZ to 55D Envelope background... .
e I : ] subtracted, is the default.
¥ \Q‘ Calibration . .
fﬁ I This behavior can be
B Appiication changed by selecting
options from the Envelope

background parameters
form.

Uncheck the “Use net
intensities in empirical
model” check box to use
looe backaround oarameters __ Raw peak intensities.

* Checking the “Use those
settings as default” box and
Moize factor at background level 20 clicking the “OK” button

will cause the entered

[ ] Enable variable curature

Curvature 1.8 values to be used as the
Use net intensities in empiical model default for all calibrations

created subsequent to this
[ ] Use those settings as default change.

k. Cancel ** The other values found

on this form should only be
changed if the user is an
expert with this tool.

*** CalToolkitEC uses 2.0
and 1.6 as well.
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<)
BRUKER
(<)

5. Calibration.

5.1 Importing the data into EasyCal.

|2} Fre gt view Methiod Gibrition  Window  Optons _Help
DESEH > D >k XDh 4 EE8M 98
% Tutorial Flease push "Nest” button
@Easr Materials
- 48 Elements Calibration

- Cornpains Check that the samples have been measured. If need be import the meas
gg Standards calibration (define the corrections, compute the calibration coefficients).
Hi"sq Measurement

Run Order Wizard

| & ~Fie~ Edit - View Method  Calibrzion  Window Opiions ~ Help

DS o+ > mb X2R f §E3M 91

@ Tutorial Data files path: C:Aldzershfritz. vosmaniDocumentshBruker\S 1Calk5td SSDALibranies\MaterialshTu
= .‘E' Materials IDisabIe riizzing stu;ls.J lDisabIe invalid stds. ‘ [ Impart raore stds. ‘
2 El t:
g =R Prepared standards | Imported  Material Preparation File:
- @ Compounds L Tutanial
%J Standards 55402 Solids Tutarial Solids
[l ’—"\S‘ e | 55403 Solids Tutarial Solids
T v 55404 Solids Tutarial Solidz
Run Order Wizard 405 Salid Tutarial Solids
PD7 to 550 S5406_Solids Tutarial Solids
vl A07_Solids Tutorial Solids
55408 Solids Tutarial Salids
55409 Solids Tutarial Salids
@ Application
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Calibration Toolbox B
Select the element
with the largest Z
value. Click on the
Mo KAL Tutorisl y| 2 .
] two left/right
Std Dew: b
g arrow buttons to
L Stat. error dominates standard deviation, scroll th rough the
Fedo ~ Undo | X elements. Or click
Pl — X on the button with
Lon) Lgnd = the element
[uadratic — ’
on e which will bring up
o —wh — the periodic chart.
&| [m* | o P
Calibration Toolbox (=]
|
» M
0 L =
‘ 0o I
b Mo KA Tistorial | [ Al Si A
Std Dew: 0.013 %% Ca: S 5 Sa By
T | Cn b
hl—}"_ Stat: enor dominates standard dewviati - - o 4 o B A
Fedo Urdo ]z- Er g Ae
Offset il 1 ( g ErTim Lu
Lluadratic — _—
238 =N H m
&| R* @ o
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Internal Standards
Note: Each element in the calibration can use a different internal standard.
A single range can be defined for the User ROl option.

[y ™

M8 ApplicationWizard - [Obsidian,evm:3] = Fl

File Edit View Calibration Window Options

DA > > (B3 XDhHEDmM il

Help -

Internal Standard:
None

This selection uses

Dser RO Std Dev: 083 %

l 011
£ 2N Higher standard deviation.
Reda Urnida

EE
- s

Offset

Quadratic

_&J [ﬁ!ﬁ [:E EZQ

Min: 18500000 ey Maw: 193200000 kel

Preview j

Q{Ob&d\an.evmi Grap. Dis. ] Standards ] Line Dverl _ Intem. Std. h Summary
——— = = = |

For Help, press F1 Status

Element/line Fe ka1/0 » h el
Intensity ratio = 4 Fe ’| the assay ach|S|t|On
SR g e » — = length to normalize
Sum of Intensities . the peak intensity to
Eopc L] StdDev. 0.1 % B P Y
i counts per second.
Fedo Unda | =
Offset —x
[om] [ on 5
Guadratic =
on 2
Min: 18500000 key Maw 19320000  key
@, e N [, A Fa
& R¥[%” o
b
!BOhsidianevmi Grap. Dis i Standards ] Line Over _ Intem. Std Summary I Preview J
_For Hapr; F1 — Status
W AppiicationWizard - [Obsidian.evm:s] o Internal Standard:
File Edit View Calibration Window Options Help o - _A" sum Of Intensities
DAEME > > (a3 YR A EHEM 92|
B = || This selection uses
i = Element/line Fe Ka1/0 » Fe .| the accumulated
Element! Sum of Intensities I : |E peak IntenSItIeS Of a”
Fa KA1/Obeigien » .
- other elements in the

calibration as the
normalizing divisor.
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Mire 12500000 ket Max: 19320000 ke

ﬁ App TArC — |
File Edit View Calibration Window Options Help o
DA &+ > @b ¥XOh 4 EE@E 982 |
Elernent/line Fe kal/0 »
Intengity ratio = 4 Fe > |
Element/ Compton (Rh)
» Faz KA1/Obsidian » E
Std Dev: 0.17 % x|
083
Feds Unda. | LE A
Offzet — %
[on] [ on E
Quadratic =

530bsidian evrn]_ Grap. Dis i Standards ] Line Ovel

17

Intem. Std. ﬁ! Summary J Preview j

Internal Standard:
Compton (Rh)

This selection uses
the Compton
scattering region of
the x-ray source
target element as the
normalizing divisor.
Generally this will be
the Compton region
of the Rh element.

5.__'{\}Obsod|an.e\rmj Grap. Dis i Standards 1 Ling Over

Intern Std @ Summary

Preview J

For Help, press F1

Status

For Help, press F1 Status
i applicatior - U | Internal Standard:
File Edit View Calibration Window Options Help - B = Usel' ROI
D o+ DP<{ =h ¥R 4 EEM 21|
= || This selection is
— = Elemertline Fekal/no : Fe ] Slmllar tO Compton
Elements Uzer ROI H
Mone . r Fa KAL/Cbsidian 3 E (Rh) Wlth the
Simol jenste: — x exception that the
S ——— v 017%
o user sets the ROI
that’s used as the
Fedo Undo Y pad .
T [ normalizer. The
Offset —x . ) .
[of] [ on 2] region is defined
ﬁ’a‘b 5] using the Min and
Oon ] .
IMin: 18500000 keVI Ma kev - R = Max fields. The
&) RS [g values are entered in
keV of energy.
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P - — &)
DESE > > B XL FEED 9
o Fﬂi‘ Fitto cutient paints lﬁ E EJEJ
Cs 16, | 01 !i[ ® - b4
| E
= Mo ’ E: -
» 360 KAL Tutoral 3 % E
3 E
StdDev  0.013% E oo
E l! Stal, error dominates standard deviation. ;_
Aok Jnda % 8 E o3
_ Ofel [EEE c
[on | & En
Quadratic — =
(o) B
& m u @ | b
5 o 0z o3 os (13 s o7 o8 [ =
I 13 Tutore dowm [5]_Grap. s [T Stonderds [[] e Over [T Srmmary T |
For Hlp, e FL s“-mi )

) e zoe view Camrmson wiow Opsans e s

[DS5a > >< B3 XADEMEED o

SB[ reememed DD s
= 10| O oo [l x

TTTTT T I I o T

T

Cafibration Toolbox =}
: Mo ’

’ Ao KAL Tuterial » %
SuDev 0.013%

! B Wb dominates standard devistion
off —x
[Lon | Jisen) ol

&l ®® ul (@

e I [ i ! [0 ' [ %
3) Tutoral devm 5] Grap. Die. | [F7]Stancards [l Line Over JF51  Sommary
For Help. press FL - ) W a1 — L B, Status
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Column Selection |i SEE i | Column Selection
Awailable Colurmns: Show the follawing columns Available Columns: Show the following columns
éEF IEZtoncDent_rattlon Move Up g‘ltumgafd . Move Up
colute Deviation andard Name
S e
b . Abzolute Deviation
“width: - : e width:
........ . < Remave Fielative Deviation Ak
53 pivels Gross Intensity 53 pixels
[refault
Columnng are displayed from the left ta right Calumnz are displaged friom the [sft ta right
[¥] Printed [¥] Printed
[T Fiked print width: 40 mm [T Fined priet width: 40 mm
Check this box if vou want to Check this bax i pou want to
[ display thiz field in each printed line [ display this field in each printed line
of the sample. of the sample
B Check this box if you want to go to B Check this box if you want to go to
the beginning of ine after this field. the beginning of line after this field

[ Reset ][ Cancel ][ Ok [ Reset ][ Cancel ]

oK

Select the columns to be displayed in the <Standards> panel

[ —— i —

DEsa > >< BB Nab@EEE

Calibration Toolbox =]
© 5 #| 2| reamm 0 [T i
Cu .|| w o oy T
I Lo
Cu KEALTutorial l‘g £
x| E

StdDev. 0.031 %

0.009
£% Higher standard deviation.

Fod ™ ’
g cu ' E
Offset — o e |
& wo = || |,
Quadratic j, o=
. Hbewarddeon 3
B x . s | ‘L‘i: 3
» e
(=] ol =] 5
Sl B> | [@® | £°

z 5 ) o B3 "
e £ Q,D.Iﬁ Swies [ w0 B Sy |

RS —
Select the next element (Cu) and click on the <Standards> tab. Note the “Std Dev.”

B9 e B view a8

DEKE > >< BB XRd|

Number

Window ~ Options  Help

Standard Mame Gross Intenzity

il 005
4 = ’ .
3 55403 _Solids 02210 01337 00273 12 6822
2 S5402_5olids 03020 02830 -0.0an B3 8759
[ S5406_Solids 02530 03062 nmvz (=1} 10,031
T S5407_Solids 0.3970 0.3843 0027 32 12152
8 55408_Solids 06340 07052 nmiz2 16 23.904
& 55405 Solids 0.0220 0.0302 0.0082 37 1.307
| 1 55401 _Solids 010a 0037 00033 38 3546

Sort the <Absolute Deviation> column and note that S5409 is the largest.
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Irisert Mew. .

To modify an item, right-click anit; to ingert a new item nght-click in an emply part of the list,

| Inzert Mew. .

3 TLrtanaI.devmj Grap. Dis. ] Standards I Line Ower. ) Summary

For Help, press F1

Select the <Line Over.> tab. Click on <Insert New...> or right-click on blank space to insert new.

Overlap correction for Cu KA1/Tracer (8.048 keV)

—i
Overlapping line: v | DK ]
NiKB1 (8.267 keV, 14%)
Cotrect by Ni KB3 (8.265 keV, 7%) Cancel
Ni KBS (8.329 kev, 0%]
Factot | O Given ) Adustable
Search parameters
Min concentration = 1000PPM Escape peaks
Distance (V) 1 300
Select the best overlap suggestion (Ni KB1 in this case).
Overlap correction for Cu KALTutorial (3.048 ke\] ﬁ
Overlapping line: - Ok
Correct by Measured VI INi k&1 4T utorial V]
Factor ) Given @ Adjustable
Search parameters o
Min concentration [ 1000FFH [¥] Escape peaks
Distance [g4] r 300 | Surn peaks

Fie: Edt View Ca n Window Options  Help
o = > =] |
Dt & > @B ¥DRMESM 9w
Overdap = Energy  DelktaEn  Remark Tupe Baze for calculation Adiustable Coefficient
NiKB1 8267 0219 M easured Ni KA1/T utorial Adjustable -0. 0005669

tab.

Note the line overlap is added to the table. To delete right click on the entry. Select the <Standards>
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DESSHE > > »h XDDhHESM o

Mumber  Standard Name

7 55407 _Solids 0.3370

3 55403 Solids 0.2210

8 55408 Solids 0.6340
i f

. e

Chemical Concentration

HRF Concentration  Absolute DE\-’iatiDlJll Relative Deviation

0.4165 0.0195 43
0.2067 0.0143 65
06961 -0.0079 il
[l .0 (1079

Gross Intensity

12152
£.822
23.904

4 55404 Solids 0.4270 0.4261 -0.0003 -0.20
5 55405_Solids 0.0220 0.0214 -0.0006 -2.6
1 55401 _Solids 01010 0.1009 -0.000 -0.12

Calibration Toclbox

1 Ni ;

»

Hi KA1 Tutorial » |2
I Std Dew: 0.062 % I ]

Fledo

Onde | 3 b
L_é
Offset — %
[on ] &
Guadratic —
Lon ] &'l

DA > > (B XDDHEEDM o1

Note the <Absolute Deviation> is now 0.0071. Less than 1/3 of the “Std Dev.”

© F || wnomten[T [T

@ L]

e P8 (o) e

Next element (Ni). Note the “StdDev.” and select the <Standards> tab.

DEESE > >D<{ =B XDRHEIM 2

Standard Marne

MHumber

3 55409 _Salids 3.0200
7 55407 _Salids 0.5270
1 55401_Solids 0.0150
5 55405 _Salids 01020
3 55403 Solids 0.2230
2 55402 _Salids 0.8080
4 55404 Solids 0.3330

Chermical Concentration

Abzolute Deviatior/  Relative Deviation

01004

*RF Concentration

24

05914 0.0644 12
0.0607 00417 219
01386 0.036E 36
02434 00264 12
07834 0.0248 -30
0.4066 00136 35

Note the <Absolute Deviation> is slightly larger than the “Std Dev.” However, when we go to the
<Line Over.> tab there are no overlap suggestions.
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Calibration Toolbox [=]
: Fe ’
4 Fz EAL Tucorial K2
I StdDev: 1.01 % I xi
Redo Urida A b
Offset % o
£
Quadratic —
2
& ®* u @

NENEE EEEE )y
o L L Ean

T N [N B

10 1305 50 0 16 0 e @ sewmscs

Calibration Teolbox

Sid Dev 033 %
0.26
Higher standard deviation.

Offset

Quadratic

o] [on |
& % u

Fieds

The next element is Fe. Note that in the figure we clicked <Fix to current point s>to adjust the x-axis.
Fe is regarded as the matrix. Because Fe is calculated as the balance, while ignoring minor elements
such as P, Si, N, it is inaccurate. We do not calibrate Fe.

DEEQ > >( BR XDhHEEMm po

&|F|»| 2[rrcamrm ] [T

-l
o tsa|n 1co|o [ x
x
E |

X [
A Mn . =
» ? B2l 5

x x - = e -
T e :
e [w"
: I
& m* ul [ »

x

BT e - s T

The next element is Mn. The “Std Dev.” is 0.33 %. The points are scattered.
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DA > D)< mB ¥RRMMHESM 9

a8 55408_Solids 0.5570 0237 -42 46.456
] 55405 _Solids 0.9030 02117 23 £1.834
1 55401_Solids 1.1570 -0.2053 17 74.589
k] 55409 Solids 0.5530 01237 22 59,325
3 55403 _Solids 1.6770 01234 ) 33.004
2 55402_Solids 0.2280 01016 -45 37.977
4 55404 _Solids 0.5320 -0.0420 7.9 52672

The<Absolute Deviation> is 0.5138 for SS407.

Owverlap correction for Mn KALTutonal (5.895 kel l. _?g_
Owerlapping line: CrkB1 [5.947 ke, 14%)
Carrect by Measured = | | Cr KaA1/T utarial v]
Factor 1 Given @ Adiustable

Search parameters —
Min concentration [l | 1000PFM [¥] Escape peaks

Diztance [eV] T 300 [ ] Sum peaks

In the <Line Over.> tab insert the overlap as shown. It is inserted in the table.

Fie Edt View Catwston  Window Optiors  Help

DEEH > >D<(BH ¥XahHEEM 9w

Mumber  Standard Mame  Chemical Concentration  #RF Concentration  Absolute Deviatiol,l' Relative Deviation  Gross Intengity
9 55409 Solids 0.5530 05318 0.0328 549 59.325

5 S5406_Solids 0.4470 04569 0.0033 22 E0.272
4 55404 _Solids 0.5320 05337 0.0077 15 52672
f 3 55403 _Solids 1E770 16718 0.0054 032 99.004
a 55408 Solids 0.5570 05533 0.0023 041 4E 456
| 1 55407_Solids 1.1970 1.1986 0.0016 013 745893

The <Absolute Deviation> for $5407 is now down to 0.0182% and the largest one is still only 0.0328 %.

Quite an improvement.
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Calibration Toolbox [=]
o
4 Cr KAT Tutorisl » |E

I Std Dew: 0.16 &4 I X

RS Higher standard deviation.

Redo | |—Lff X

Offzet
p— ]
o (o) [F
Quadratic —

o] [on |
& R %

DEEE > >< B0 Xoh @EED o

DD el

= oo | @

o) G |
& m* % (@

AN S e S A Y M AR O T S R e o S N P T )
Gueowe [ oo [T Swves [B) et I Gomwy |

[ = —
Next is Cr. Adding an offset improves the “Std Dev.” But let’s look at overlaps.

DAESH > >D< D YXDRHMESD 9w

Mumber  Standard Name  Chemical Concentration:  <RF Concentration  Absolute Deviation!  Relative Devigtion  Gross Intensity

8 alie 01110 00a11 h
5 55405_Salids 0.2060 nz1a7 0 B2 .02
4 55404_Solids 0.7740 0.7852 ooz 1.5 E8.05
1 55401_Salids 01380 01486 00106 w7 26.35
7 S5407_Solids 30300 30251 -0.0043 016 20239
B 55406_Salids 2.0010 2.0032 n.oo2z 0.1 14331
3 55403_Solids 0.4530 04810 -0.0020 -0.43 47.59
2 S5402_Solids 0LES20 0ER13 -0.0007 -0 53.59
9 55409 _Solids 1.3180 1.3187 0.0007 0.051 10097

The largest<Absolute Deviation” is 0.0299.
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Overlap comrection for Cr KA/ Tutorial (5.415 keV) |

Owerlapping line: VOKBT (5428 keV, 14%) &
Carrect by Measured | 1Y KA1/ Tuborisl “
Factor 7 Given @ Adiustable

Search parameters o

Mir concentration - [ 1000FFH [¥] Escape peaks

Distance [eY] I 300 [} Sum peaks

Select the V KB1 overlap, and click OK.

E D i =\ Al C) ;
DS o >D< BB VMDD MESM 9
Mumber  Standard Mame  Chemical Concentration  »RF Concentration  Absolute Deviatiu:n,l' Relative Devistion  Gross [ntensity
g o1 ]
z ! , 0 5 ba, o
7 55407_Solids 3.0300 30192 0.0108 -0.36 202.39
9 55409 Solids 1.3180 1.3251 0.0071 0.54 100.97
5 55405 Solids 0.2060 02125 0.0065 ek, 31.02
g S5406_Solids 2000 20075 0.0065 0.3z 1433
3 55403 Solds 0.4630 0.4576 (0.0054 1.2 47.59
1 55401_Solids 01380 01390 00010 074 26,35
2 55402_Solds 0.6520 0.6529 0.0009 013 59,99
It only improve the <Absolute Deviation” from 0.0299 to 0.0200.
% : s | 5% |
varlap correction for Cr KALTutorial (5415 kal) TR
Overlapping line: I Fe KB3 Escape [5.219 kel 7]
Correct by Measured v] IFe K& #T utorial
Factor ) Given @ Adjustable
|
Search parameters o
tin concentration = [l THOOERM [V Escape peaks |
Distance [g%] L 300 [} Sum peaks
Next select the Fe Escape peak. And click OK.
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DESE * DB XDREAEEM o

Murnber

Standard Mame

Chermical Concentration

#RF Concentration
o110 0.0347

Absolute Deviatio | Relative Deviation  Gross Intensit

¥ 55407 _Salids

B 55406 _Saolids 20010 2.00328
4 55404 Solids 07740 0.7aav
2 S5402_Salids 0.6520 0.6444
1 55401 _Salids 01380 01443
3 55403 _Salids 04630 0.4538
5 55405 _Solids 0.2060 0.2090

This again improves the deviations.

DS > D ab Xah A EmMm 9w

Tutorial. devm

Calibration Toclbox @ e
D >E{BRFYDREEED o
| v . &5 #| 2[00 &l
1 5 L o fo I x
> 2
V KAT Totorial v 2
Std Dew: 0.0074 % P.< .
A P
A% Stab emor dominates standard deviation.
Redo | [ Undo | L{f A
Offzet

[on] ]
Quadratic
(o) S A

Biwomon [ ooy 0u [T Sover [T wraeer [0Sy

e S

Next is V. It is already good.

— e
| he ﬁ'.&i
ApplicationWizard | =] Saven | 3 Caltuations %0 @

-

Save changes to Tutorizldevm?

Curr
“ : e J[ M J[ conce
B Tutorial devm '§ Grap. Dis. I Standards JE Fiename: | ITETE
= 1P, press - = Saveaslype | ApphcatoriimdDi Fies [* dev| - .
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Select the left most tab, <Tutorial.devm>. Then click > . Click <Yes> to save the results.
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6. Modules.

DS E > D)< mb YLD £ 530 9

|2 Tutors
=} aatMaterials
M Elements

@ Compounds Current material

" Cunent modules libraty file:

Tutosial

%5 standards
=] '.:a_ Measirement
M~ o o
= ‘\& Calibration
A Manage Standards
A& compute
[l

Modules

To create and edit modules. A module is a value that is computed from the concentration of measured compounds or from other modules

For Example:

Comparent: “Anctor;

Custert fuschi ks ndian |5, = (raeet]

Currers ki b mebtion |2, v
() Purdab el ) Inkmeveechite s of eskerdalen

[ Corbtions

Conponest | et

E"'ﬂmui ML_H_....—

Cunent modue for edificn: Sy
@ Printable it
] Condizon

* Intsmediste sep of eakeubsion

Enter a name to show with
results

Select a function

Enter the arguments

OR

Compamen: w s

Curverd maochie for scorr (s »
(=) Partsle oo () Inkeaediate slap o oakulsion

7] Corciion

Cormprnan | temr

H 0 = o

Dot sl fos sciiory iy

D Pinkable el () mascias g of caloulalion

[Cicerinn

Comparert | i
N ] » o

Enter a name to show with
results

Select a condition

Enter the arguments

Madulzs

.{"’B Save changes to Tutorialmib?

[ (]

B save as L=
|_§_:§_ | Savein: | Methods -8
Name ° Date modified T
No items match your search.
Cancel ] i il | r
File name: I Tutoralmib II Save I
Save astype: |Modules Librares {"mb) x| [ Cancel |
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7. Saving the calibration.

7.1 The appinstall package.

DEEE > > md AXDD A WED s

- p— Comtmtns | it
Y - p— e
oo | Application

Ve

o—

2] Tutorial | Info/Save | Methods | Eumsmml Chemisty: mienl

* Materials r

T 35' . Z  Fomda Rule

@ {9 Messirement 3V Irdtiskze concentratio. .
3 24 G Initisize concentratio...

@ 1 catraon % Mn Indialize concentrato..
TS5 Modues % Fe Matiix (balance to 100%)
- 2 N Iniislize concentratio...
T80 Acplcation 2 Cu Intisize concenlrato..

42 Mo Intiskze concentratio...

Check the <Chemistry Rules>

IrdaiSave | Hethod Chemisty: ries
n o l | 5 | Elements map | 1y
Bt
fpph
# i__& Calbra 'V KA1/Trace: does nat b dbrali ditle chilt
Ci Kil1/Trace doss nal St el i i
_H"‘“‘““ Mn}ﬂ"tm&:nmmmmmmmmm
; COiEchon daly
(] Apebcation 1 KA/ Tiace does not have cabral v i
Cu KA/ Tracer does not have calbral i cht

Mumn.xadmmthmuﬁm:mdmmm
m FAL MUwﬁnlacmm &

Rh KAT/Traces Complon rot callbrated
Fih KA1 /Traces Compion does nol heve cablbation compatible dill conection data
T il cail fd e e ol

i conection data.

Wy CahStd

Select the <Info/Save> tab, then File -> Save to save the calibration installation package.
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ApplicationSetup

o 7ol ]

'-:3 Sawing Installation package as C\Documents and Settings\FritsiMy Doc \51Caf5td S50 it 108 Tukorial. 1 23-4567-89. appinstal

Note the folder as set by EasyCal where the appinstall package is stored.

7.2 Installing the appinstall package.

V. G| Typs o banckbed
ST el 12348 REN APPHNG. ENEITE 10 A

& 32 w0t Shaisd Foiders|Engraesng) [04)
- EpecHE B Votuma (54
& v Progeecss 24

CrrT I W firmniaend, @

Open S1Sync, connect to the instrument. Open File Explorer and find the folder from 6.1.
Drag and drop the appinstall file on the package folder.
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Device Tools Windows Help

. §1 Sync Explorer
i 2] Refresh [(EFolderlp 8] Download & Upload
\BRUKER\package
= [ SMx-108 A1 Name Size Type Date Modified
I3 Application Data = SMX-108 Tutorial 123-45_. BKB APPINS.. 2/6/201510:40 AM
& ARCHIVE _—
3 BINARIES Bl App Installer
= £ BRUKER i =>Starting Installation Process __J
23 Autold +++=>Package "BRUKER\package\SMX-108. Tutorial. 123-4567- -
3 Data = fe9.appinstall’ installed successfully
€3 Desktop ('\BRLKE!\IIbmnatms.df‘) not found.
= Documents and Settings =>Performing etallation Cleancp
. \BRUKER \User AppPreferences.uap file deleted
&3 EDX Databases esetting Running Frograrms
3 lost+found IREBOOT
J package
i Setup
2 System
2 TitanCals
0 LBOOT
29 My Documents
(=9 Network
= Program Files
3 Recycled v |
| = & My Computer
# e (CY)
# 3 Wwmware-hostShared Folders\Publicy (J3)
# 2 \wmware-host\Shared Folders\Engineenng), (Q
# % SpectraEDX Volume (S4)
& < Projects (27

= )

Select Tools -> Bruker Installer to install the appinstall package.

7.3 Testing the calibration.

[
e

Ty I
& »>
Select Analysis Type

Alloys

Alloys SMARTGrade
WBuxliary Alloys
RadProfile

T

72 02-06 10:47
Time 28.0
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<)
BRUKER
(<)

Login to the instrument
and click
<APPLICATION>

Select the new
calibration and click
<OK>

Note that the new
name is displayed in
the <APPLICATION>
button

Take an assay and note
the concentrations as
well as the Sum and
Ni/Cr ratio are shown
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